
 1

What’s New in Chief
Architect X5

Welcome to Chief Architect X5. This guide has been 
written to help our upgrading customers make a 
smooth transition from earlier versions of Chief 
Architect to Chief Architect X5. 

Contents
•      Before You Begin
•      New and Improved Features

Before You Begin
There are many new features in Chief Architect X5, and many existing features have changed. These changes 
affect the way Chief Architect functions, so it is very important to be familiar with them. 

• “Getting Started Check List” on page 1

• “For Files Created in Version X4 and Prior” on page 4

• “For Files Created in Version X3 and Prior” on page 4

• “For Files Created in Version X2 and Prior” on page 5

• “For Files Created in Version 10 and Prior” on page 6

Chief Architect X5 can open the .PL1, .LA1, .plan, and .layout files from prior versions. Before opening any 
files created in earlier versions of Chief Architect, it is important to be aware of changes made in the newest 
version and the effect they may have on your legacy plan and layout files. For details, see “For Files Created in 
Version X3 and Prior” on page 4,  “For Files Created in Version X2 and Prior” on page 5 and “For Files Created 
in Version 10 and Prior” on page 6. 

As with any software, it is always best to finish any current projects you may have in progress in the version of 
the software in which you began them. If you do decide to bring a project forward, be sure to take the time to 
verify that everything in your drawing is correct when it is opened the new program version.

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief Architect X5. More 
information about each of these steps can be found after the checklist.

1.      Check for and Install Program Updates
2.      Migrate Legacy Library Files
3.      Migrate Custom Graphics Files
4.      Review the New Features List
5.      Review Your Preferences Settings
6.      Create new custom Template Plan and Layout files
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7.      Set up Custom Toolbar Configurations
8.      Export Entire Plan
9.      Check www.chiefarchitect.com for more information

1. Check for and Install Program Updates
Program updates contain improvements to the original release version and we recommend using the most 
current version available. By default, Chief Architect checks for program updates every day when you launch 
the program. Please note that program updates are available for download, which means that you need internet 
access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 

• Visit the Program Updates page on the Chief Architect Web site at www.chiefarchitect.com. 

2. Migrate Legacy Library Files 
Library content from previous program versions cannot be installed or copied into the Chief Architect X5 
library. If you upgraded from version X1 or later and have custom library content on your computer from that 
program version, the program installer will locate it and ask if you want to migrate it into the Chief Architect 
X5 library.  

You can import library files from versions X1 through X4 at any time by selecting Library> Import Library 
(.calib, .calibz) from the program menu .In addition, library files from versions 10 and prior can be imported 
by selecting Library> Convert Legacy (.alb) Library Files from the program menu.

3. Migrate Custom Graphics Files
If you have custom graphics files, including textures, images or backdrops, that you were using in a previous 
program version, you can copy them manually using Windows Explorer for use in Chief Architect X5. 

• Copy custom texture files to the Chief Architect X5 Textures folder located in the Chief Architect X5 Data 
folder. 

• Copy custom image files to your Chief Architect X5 Images folder located in the Chief Architect X5 Data 
folder. 

• Copy custom backdrop files to your Chief Architect X5 Backdrops folder located in the Chief Architect X5 
Data folder. 

In Chief Architect X4 through X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X5. In version 10 and prior, they were located in the program’s installation directory, in folders that 
began with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.

4. Review the New Features List 
There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X5:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 

See “New and Improved Features” on page 7. 

http://www.chiefarchitect.com/
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5. Review Your Preferences Settings 
Any changes that you made to the Preferences settings in your previous version do not migrate 
into Chief Architect X5. You should review all the settings in the Preferences dialog to make 
sure that they are set to suit your drawing needs.

6. Create new custom Template Plan and Layout files 
Chief Architect X5 installs a selection of template plan and layout files that have been set up to 
take advantage of the program’s updated tools and features. For best results, it is recommended 
that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X5

• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program 
version, it is very important that you take the time to carefully review all the default settings in 
the file, making sure that they will continue to suit your needs in X5. First, make copies of your 
custom templates in the Chief Architect X5 The Templates directory is located in the Chief 
Architect X5 Data folder in Windows Explorer. Next, open each template as you would a 
regular plan or layout file, by selecting File> Open, and then save any changes you make by 
selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout 
template from the same program version, as well. As with a template plan, take the time to go 
through the layout template’s defaults and make sure they are suited for use in X5 and that their 
line weight scales do not conflict with those in your template plans.

7. Set up Custom Toolbar Configurations 
It is possible to migrate toolbar configuration files from previous versions to Chief Architect 
X5; however, it is not recommended because it is likely that you will be missing new tools 
available in version X5. 

Instead, we recommend that you set up your custom toolbars the way you would like them in 
Chief Architect X5. You may find it most effective to customize your toolbars as you get used 
to working in the new program version, rather than beforehand.  

8. Backup Entire Plan
Before migrating a legacy file created in Chief Architect X4 or prior, it is a good idea to open 
the plan in the program version in which is was created and use the Backup Entire Plan tool 
(Export Entire Plan in version X3 and prior) to export the plan with all associated support files, 
including textures, backdrops and images.  

9. Check www.chiefarchitect.com for more information



4

Chief Architect  X5 Migration Guide

If you have additional questions about the changes in Chief Architect, up to date information is available in the 
Support section of our web site. You can also post questions on the Chief Talk web forum at 
www.chieftalk.com.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or 
prior, bear in mind the following before you open legacy files in Chief Architect X5. 

1. Roof Overhangs and Framing
In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in 
Version X5, they are measured to the outside of the fascia or shadow boards, if present. In legacy plans opened 
in Version X5, this will not affect the appearance of roof planes in floor plan view because in X4 and prior, roof 
plane polylines represented the projected framing area whereas in Version X5 they represent the total projected 
area.  But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials
In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior side of 
door. This was corrected in Version X5. Doors modified to work around the old behavior could be affected in 
legacy plans opened in Version X5. 

3. Door Swing Direction and Louvers
Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills
In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not 
wrapped. In legacy plans opened in Version X5, the extents of wrapped lintels and sills will be adjusted so that 
they equal their Extend setting.

5. Cabinet Feet
The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert 
into cabinets effectively. In Version X5, the offset is set in the Cabinet Specification dialogs. When legacy 
plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if 
one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, 
then those objects’ labels will display in that view when the plan is opened in Version X5.

7. Invisible Beams
The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy plans 
are opened in Version X5, any Invisible Beam walls will be converted to Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following before you open legacy files in Chief Architect X5.

1. Text Styles
The appearance of a number of objects that include text - including object labels, the North Pointer, Sun 
Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text 
Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect X5.

2. Light Sources

http://www.chieftalk.com/
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The illumination created by light fixtures and Added Lights was improved in Chief Architect X5. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X5.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements before you open legacy files in Chief Architect X5.

1. Material textures, images, and backdrops
Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X5 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X5. This tool is renamed Backup Entire Plan in version X5.

2. Floor and ceiling finish thicknesses
In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

3. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X5.

4. Auto Adjust Height
The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height checkbox. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

5. Adjustable Thickness Walls
In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X5 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.

6. Stairwells defined by railings
Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X5. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

7. Deck rooms
In legacy plans opened in Chief Architect X5, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

8. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X5. 
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The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).

9. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X5, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog.

10. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X5 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X5.

For Files Created in Version 10 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version 10 or 
prior, these additional steps are also suggested before you open legacy files in Chief Architect X5.

1. Select the desired Layer Set 
Before migrating a legacy file created in Chief Architect Version 10, open it in Version 10 and make sure that 
the active layer set is one that is useful in most situations. Extensive changes to layer sets since Version 10 
allow only the active layer set to be migrated in Chief Architect X5.

2. Set up your Legacy File Conversion Preferences 
Several different preference settings allow you to control how legacy files from Version 9.5 and prior are 
migrated into Chief Architect X5. You may want to do some experiments with these settings so that you fully 
understand how they affect your older plans when they are read into Chief Architect X5:

 a. Set your legacy text and dimension conversion fonts - Set your Legacy Text Conversion and Leg-
acy Dimension Conversion fonts in the Preferences dialog before opening any old plans. Use the 
same settings here that you had in your preferences for your previous version of Chief Architect so 
that your text and dimensions will look the same.

 b. Set your legacy plan and layout page setup information - Page Setup information can be done on 
an individual plan basis. Use the Page Setup preference for legacy plans and layouts so that your plans 
and layouts are set up the same way they were in your previous version. Note: You should make sure 
you leave the scale for layouts at 1 to 1.

 c. Set your legacy layer conversion settings - Significant changes have been made to improve the setup 
and control of layers. Preference settings have been provided to control how your legacy plan layers 
are converted when you open a previous version plan in Version X5. By default, layers should be con-
verted into the new format so that they more closely match the defaults that we provide in the template 
plans. You can modify these settings so that your layers more closely match how they looked in your 
previous version.

3. Replace problem symbols
In recent versions of Chief Architect, any symbols placed in a plan are saved with the plan file and can be read 
by Chief Architect X5. If you open a plan file created in an older version of Chief Architect and notice 
problems with a symbol, however, you can either delete it or replace it with a new symbol from Chief Architect 
X5 library.
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New and Improved Features
The following is a list of  new and improved features 
in Chief Architect Version X5.

Installation
• Can now choose to migrate some or all library 

content from the previous program version.

Program Overview
• Moved all tools in three-level submenus for eas-

ier access.

File Management
• Backup Entire Plan tool now backs up inserted 

.pdf files.

Preferences & Default Settings
• Can now export and import plan default settings.
• The 3D Settings dialog was renamed 3D View 

Defaults and can now be accessed via the Default 
Settings dialog.

• Expanded ability to edit defaults settings in all 
views.

Toolbars & Hotkeys
• Removed ability to assign same name to multiple 

custom toolbars.

Layers
• New “Casings, Exterior” and “Casings, Interior” 

layers for door and window casings.

Creating Objects
• When creating an object on a layer that is not 

turned on, you can now choose to Cancel.
• Polyline- and Spline-based objects can only be 

created when their components have the same 
layer and display attributes - including line style 
and color.

Editing Objects
• Corner Boards and Quoins added to the Delete 

Objects dialog.
• Can now delete Manual and Automatic Dimen-

sions separately in the Delete Objects dialog.

Walls, Railings & Fencing
• The Railing and Handrail tabs in the Wall 

Specification dialog were renamed to improve 
usability.

• New settings to specify profiles for top, middle 
and bottom rails as well as beams over railings.

• Can now specify the height of bottom rail or shoe 
on Railings and Deck Railings.

• No Shoe and Raise Shoe settings were renamed 
Include Bottom Rail and Raise Bottom Rail.

• Can now control the material of a railing’s over-
head beam, as seen in 3D views.

• Align With Above/Below  edit tools now 
work with Invisible Walls.

• New Named Values for walls.
• Bearing Wall checkbox was renamed Create 

Wall/Footing Below to improve clarity.
• Legacy Invisible Beam checkbox was removed 

from the Wall Specification dialog. Invisible 
Beam walls in legacy plans will be converted to 
Invisible Walls when opened in version X5.

Rooms
• Improved feedback in the Room Specification 

dialog if the selected room has multiple rooms 
with different floor heights located directly above 
it.

Doors and Windows
• Can now display door and window casing in floor 

plan view.
• Can now specify the Depth of door and window 

casing. 
• New “Casings, Exterior” and “Casings, Interior” 

layers.
• Can now specify wrapped lintels and sills on win-

dows with recessed casing.
• Improved usability of Extend setting for lintels 

and sills.
• New Reverse Interior/Exterior option in the 

Door Specification dialog. Don’t use with cus-
tom muntins.

• Improved how Bi-fold doors, their hinges, and 
their louvers are generated.
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• Can now show Bi-fold doors as open in 3D 
views.

• New Show in Plan setting lets you control the 
display of the concrete cutoutfor  doors and win-
dows in floor plan view. 

• Improved Louver direction behavior for doors.
• Improved how door materials are handled with 

the swing side is changed.
• Improved display of window frames and sills in 

floor plan view.
• Windows can now have a lintel without also hav-

ing a sill.

Foundations
• New Show in Plan setting for doors and win-

dows lets you control the display of their concrete 
cutout in floor plan view. 

Roofs
• Can now specify roof Ridge Caps.
• Can now specify Shadow Boards for roof fascia.
• Added option to generate automatic frieze on 

eaves only, gables only, or both.
• Both the projected and actual areas of roof planes 

are stated in the Roof Plane, Ceiling Plane, and 
Roof Hole/Skylight Specification and dialogs.

• In floor plan view, roof plane polylines now 
reflect the thickness of the fascia and shadow 
boards rather than the extents of the framing.

• Redesigned Change Roof Pitch or Height dia-
log.

Stairs, Ramps & Landings
• No Shoe for Rail setting was renamed Include 

Bottom Rail on Landings for greater clarity. 

Framing
• The bottom plates of framed interior walls are 

now specified as Treated if built on a monolithic 
slab foundation. 

• Posts  now use their default size when placed 
under a floor or ceiling beam instead of inheriting 
the beam’s width. 

• Framing members can now display Start and End 
indicators when selected.

Electrical

• Improved how Auto Place Outlet  tool posi-
tions outlets for appliances.

• Obsolete Soft Shadows Quality setting removed 
from Electrical Service Specification dialog for 
light sources.

Trim & Moldings
• Can now specify whether automatic frieze mold-

ing generates under eaves only, gables only, or 
both.

• Improved offset for Cabinet Feet.
• Handrail profiles no longer require that the bot-

tom edge be drawn on the left.

• New Auto Place Corner Boards  and Auto 

Place Quoins  tools.
• Corner Boards and Quoins added to the Delete 

Objects dialog.

Cabinets
• New Specify Appliance setting allows multiple 

front appliances in the same cabinet.
• Can now assign multiple door and drawer styles 

to a single cabinet.
• New Offset setting for Cabinet Feet.
• New “Double False Drawer” option for cabinet 

fronts.
• Drawers and Double Drawers automatically 

change to False Drawers when a cooktop appli-
ance is inserted into a cabinet.

• “Plain” cabinet doors renamed “Slab” cabinet 
doors.

Other Objects

• New Pyramid  Primitive shape tool.

The Library
• New Update Library Catalogs option checks 

for updated Core, Manufacturer, and Bonus Cata-
logs content.

3D Views
• 3D Settings dialog was renamed 3D View 

Defaults and can now be accessed via the Default 
Settings dialog. 



New and Improved Features

 9

• Backdrop name now displays in 3D View 
Defaults.

• New Isometric Overview tools.
• Can now include floors below the current floor in 

Floor Overviews.
• New Plan Display tab in Camera Specification 

dialogs allows control of camera symbol size, 
Clip Plane Indicator length, and focal point dis-
play.

• New Label tab in Camera Specification dialogs.

• Wall Elevation  tool now recognizes room 
definition created by invisible walls and railings.

• Can now modify a saved camera without saving 
your changes.

• New Clip To Sides setting lets you limit the side-
to-side extents of cross section/elevation views.

• Can now save Cross Section Slider settings with 
saved cameras.

• New position text field in Cross Section Slider 
dialog.

Rendering & Ray Tracing
• New Use Generated Sky option creates a pan-

oramic backdrop of a daytime sky.
• New Progressive Ray Tracing improves ray trace 

quality the longer you let it run.
• Removed settings from the Ray Trace Options 

dialog that were made obsolete by Progressive 
Ray Tracing.

• Can now Stop  a ray trace in progress without 
cancelling it.

• New option to specify a saved ray trace image’s 
size in inches (mm).

• Can now specify the line color of Line Drawing 
in the Watercolor Rendering Technique.

Dimensions

• New Running Dimension  tool.

• New Auto Interior , Auto NKBA , Auto 

Elevation , and Auto NKBA Elevation 

Dimension  tool.. 

• Manually-drawn Dimensions  and Automatic 

Dimensions  now have separate parent tools 
and submenus.

• Can now delete Manual and Automatic Dimen-
sions separately using the Delete Objects dialog.

• Improved how dimensions locate door and win-
dow casing.

• Can now specify whether and how furniture is 
located by dimensions in floor plan and cross sec-
tion/elevation views.

Pictures, Images, & Walk-
throughs

• Can now import .pdf files.

• New Create Walkthrough Path  tool with 
editable Key Frames.

• The Resize Picture  edit tool is now available 
for selected metafile boxes and pdf boxes, and 
was renamed Point to Point Resize. 

Importing & Exporting
• Can now specify whether imported .dxf/.dwg 

drawings are placed at their original location or at 
the origin (0,0).

Printing & Plotting
• The default Print Range in the Print dialog is 

now All by default and your last choice for this 
setting is remembered between program sessions.

Schedules & Object Labels
• Can now display object labels in cross section/

elevation views.
• Can now rotate object labels independent of the 

actual object.
• Improved differentiation and description of 

Angled Front cabinets in schedules.

Ruby Console
• New Named Values for walls, rooms, roof planes, 

Added Lights, and view names.
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